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Manual: Empirischer GIS Ansatz (EGA) 
Kapitel 1.2 des Syntheseberichts 

 

Einleitung 
Dieses Handbuch erklärt, wie man den empirischen GIS Ansatz (EGA) aus Kapitel 1.2 des 
Syntheseberichts WoodFlow anwendet und dessen Resultate auswertet. Dabei werden detailliert alle 
Arbeitsschritte aufgezeigt, um das Schwemmholzpotential Vpot inklusive Eintragsflächen Fpot sowie in 
einem zweiten Schritt die Schwemmholzfracht Vest eines Einzugsgebiets abzuschätzen. 

 

Software  
Der EGA wurde mit ArcGIS 10.8 (ESRI) entwickelt und steht als Werkzeug in Form einer ModelBuilder-
Toolbox (.tbx-Datei) zur Verfügung. Für die Anwendung wird demnach die Software ArcGIS sowie die 
Erweiterung Spatial Analyst benötigt. Die entsprechende Toolbox (WoodFlow_EGA.tbx) für die 
Anwendung des EGA steht auf der Projekt-Homepage www.woodflow.ch als Download zur 
Verfügung. 

 

Datengrundlage 
Folgende Daten werden benötigt, um die Modellierung des Schwemmholzpotentials mit EGA 
durchzuführen (Kontaktangaben für den Datenbezug siehe www.woodflow.ch): 

- Shapefile des zu untersuchenden Einzugsgebiets: Dieses muss durch den Anwender selbst 
definiert werden. Eine einfache und schnelle Methode zur Extraktion des 
Untersuchungsgebiets liefert das BAFU Produkt „Topographische Einzugsgebiete Schweizer 
Gewässer“ (EZGG-CH). Der Geodatensatz kann unentgeltlich unter folgendem Link 
heruntergeladen werden:   
https://www.bafu.admin.ch/bafu/de/home/themen/wasser/zustand/karten/geodaten/einzu
gsgebietsgliederung-schweiz.html 

- Shapefile des Gewässernetzes der Schweiz (GWN.shp): Dieses wurde für die GIS Anwendung 
spezifisch bearbeitet, d.h. mit ökomorphologischen Kriterien (u.a. Gewässerbreite) und 
Flussordnungszahl verlinkt. Das entsprechende Shapefile kann auf Anfrage bei der WSL 
bezogen werden. 

- Polygon Feature der Schweizer Waldfläche (Silva_V25) aus dem SilvaProtect-CH Datensatz. 
Dieses kann auf Anfrage für den gewünschten Untersuchungsperimeter bei Swisstopo 
bezogen werden. 

http://www.woodflow.ch/
http://www.woodflow.ch/
https://www.bafu.admin.ch/bafu/de/home/themen/wasser/zustand/karten/geodaten/einzugsgebietsgliederung-schweiz.html
https://www.bafu.admin.ch/bafu/de/home/themen/wasser/zustand/karten/geodaten/einzugsgebietsgliederung-schweiz.html
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- Polygon Feature der Schweizer Forstkreise (Forstkreise_LFI), inklusive Daten aus dem 
Landesforstinventar LFI (WSL, 2016). Das entsprechende Feature kann auf Anfrage bei der 
WSL bezogen werden. 

- Karte des Holzvorrats [m3/ha] in Schweizer Wäldern (VHMV.tif): Das entsprechende 
Rasterfile (25 x 25 m) kann auf Anfrage bei der WSL bezogen werden. Wichtiger Hinweis: Die 
Holzvorratskarte ist zurzeit noch kein offiziell veröffentlichter LFI-Datensatz und darum nicht 
für kommerzielle Zwecke verfügbar. Für wissenschaftliche Studien oder für Aufträge aus 
öffentlicher Hand (Kantone, Gemeinden etc.) kann der Datensatz aber bezogen werden. 

- Polygon Feature der Hangmuren-Trajektorien (EV_HM) aus Silvaprotect-CH für die 
Ausscheidung der potentiellen Rutschungsflächen. Dieses kann auf Anfrage für den 
gewünschten Untersuchungsperimeter beim BAFU bezogen werden. 

- Polygon Feature der Murgang-Trajektorien (EV_Mur) aus Silvaprotect-CH für die 
Ausscheidung der potentiellen Murgang-Eintragsflächen. Dieses kann auf Anfrage für den 
gewünschten Untersuchungsperimeter beim BAFU bezogen werden. 
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Voreinstellungen in ArcGIS 
Folgende Schritte müssen als Voreinstellung gemacht werden, um das Modell EGA in ArcGIS laufen 
zu lassen: 

- Auf dem Computer einen Home-Folder definieren, in dem die Modellierung durchgeführt 
werden soll. 

- Öffnen eines neuen ArcMap Dokuments (*.mxd File). Speichern und Benennen des ArcMap 
Dokuments im entsprechenden Home-Folder (File > Save as). 

- Im Home-Folder eine neue File Geodatabase kreieren, benennen und als Default bestimmen: 
a) Catalog > Home-Folder > Rechter Mausklick > New > File Geodatabase 

 
b) File Geodatabase > Rechter Mausklick > Make Default Geodatabase 

 
 

- Speichern des *.mxd Files(File > Save). Somit ist das ArcMap Dokument bereit für die 
Anwendung. Alle Berechnungen der EGA Modellierung werden in der neu definierten Default 
Geodatabase ausgeführt und die Resultate dort gespeichert. 
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Anwendung des Modells EGA 
Folgende Schritte sind durchzuführen: 

- Überprüfen, ob die einzelnen Funktionen  
- Öffnen der Funktion Grundlagen in der Toolbox WoodFlow.tbx. 

Wichtig: Zuvor prüfen ob der Workspace Pfad richtig definiert ist: 
   Properties > Environments > select Workspace > Values… 
   Current Workspace & Scratch Workspace = Default Geodatabase 
 

 
 

- Eingabeparameter ausfüllen bzw. Link zum Ablageort der entsprechenden Geodaten liefern 
(siehe Kap. „Datengrundlage“ weiter oben).  
Das verwendete Einzugsgebiet definiert den modellierten Perimeter, sodass keine weiteren 
Einstellungen vorgenommen werden müssen. 
Wichtig: Die Outputs mit dem Pfad %workspace% sollten nicht geändert werden, da die 
Nomenklatur für die nächsten Prozessierungsschritte gebraucht werden. 
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- Auf „OK“ Button drücken und Modell laufen lassen. Die Modellierung ist erfolgreich 
abgeschlossen, wenn die Meldung „Completed“ auftaucht. 
Wichtig: Die Output-Files werden automatisch in ArcMap (*.mxd) importiert. Diese Files 
müssen im geöffneten ArcMap-Dokument bleiben, da der nächste Modellierungsschritt mit 
relativen Pfaden arbeitet. 
 

- Nun können die verschiedenen Szenarien (SH30, SH100, SH300) einzeln berechnet werden, z.B. 
mit öffnen der Funktion SH100 in der Toolbox WoodFlow.tbx. 
Wichtig: Zuvor prüfen, ob der Workspace Pfad richtig definiert ist: 
   Properties > Environments > select Workspace > Values… 
   Current Workspace & Scratch Workspace = Default Geodatabase 
 

- Es bedarf keiner Änderung der Eingabeparameter und deren Pfade. Auf „OK“ Button drücken 
und Modell laufen lassen. Die Modellierung ist erfolgreich abgeschlossen, wenn die Meldung 
„Completed“ auftaucht. Die Berechnungszeit des Modells variiert je nach Grösse des 
Einzugsgebiets zwischen wenigen Minuten bis zu ca. einer Stunde (bei >100 km2 
Einzugsgebietsfläche).  
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- Nach Abschluss der Modellierung sind nun alle Resultate zum Schwemmholzpotential und zu 
den potentiellen Eintragsflächen im Untersuchungsgebiet in Form von Geodaten (Raster und 
Shapefiles) und Tabellen (Geodatabase-Table) in der Default Geodatabase gespeichert. Eine 
genaue Beschreibung der einzelnen Outputs ist hier im Anhang oder im Excel-Template 
EGA.xlsx zu finden (Download auf Website www.woodflow.ch). 
 

- Die generierten Raster und Shapefiles können nun in ArcMap analysiert werden. Sie helfen, 
die potentiellen Eintragsflächen von Schwemmholz räumlich explizit zu identifizieren. So 
können z.B. besonders gefährdete Teileinzugsgebiete identifiziert werden, in denen 
Handlungsbedarf besteht (z.B. für forstliche oder wasserbauliche Massnahmen). 

 

Hinweis: Die Funktion Erase in der Toolbox WoodFlow.tbx ist in den anderen Funktionen (SH30, 
SH100, SH 300) integriert und muss nicht separat angewendet werden. Falls die letzteren Funktionen 

eine Fehlermeldung zeigen ( ), muss die Funktion Erase im Modelbuilder zugeordnet werden: 
   Rechtsklick > Edit > öffnet den ModelBuilder 
.   Funktion Erase suchen, öffnen und richtigen Pfad zuordnen (7-mal) 

 

  

http://www.woodflow.ch/
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Export in Excel-Template 
Mit dem Excel-Template EGA.xlsx (Download auf Website www.woodflow.ch) können die Resultate 
der EGA-Modellierung nun schnell und einfach zusammengefasst und visualisiert werden. Des 
Weiteren kann mit Hilfe der Abminderungsfaktoren auf die geschätzte Schwemmholzfracht 
geschlossen werden. 

- Als Erstes müssen die Output-Tabellen der drei Szenarien als Textfile (*.txt) abgespeichert 
werden. Im ArcCatalog können die entsprechenden Tabellen 
(Schwemmholzpotential_SH30/SH100/SH300) aus der Default-Geodatabase mit „drag & 
drop“ in das geöffnete ArcMap-Dokument kopiert werden. Dann im „Table Of Contents“ auf 
die Ansicht „List By Source“ wechseln. 
 

 
 
Danach entsprechende Tabelle (z.B. Schwemmholzpotential_SH30) auswählen > Rechter 
Mausklick > Data > Export 
 

 
 
Unter „Output table“ auf den „Browse“ Button drücken 

http://www.woodflow.ch/
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Speicherort wählen und unter Save as type > Text File auswählen und unter entsprechendem 
Szenario-Namen abspeichern. 
 

 
Dasselbe Prozedere auch für die anderen Beiden Output-Tabellen ausführen. 
 

- Nun das Excel-Template EGA.xlsx öffnen. Im Worksheet „Berechnung Potential & Fracht“ 
können die im vorherigen Schritt konvertierten Textfiles importiert werden. 
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Danach unter Data > From Text/CSV das entsprechende Textfile auswählen und importieren. 
 

 
 
Im Text Import unter Delimiter > Comma auswählen, damit die Spalten richtig getrennt 
werden. Dann Load drücken. 
 

 

Hinweis: In Windows 10 wird der Import der Textdatei automatisch in ein neues Excelsheet kopiert. 
Hier muss man die importierten Zeilen (Zeilen 1 & 2) nochmals kopieren und an der richtigen Zelle im 
Worksheet „Berechnung Potential & Fracht“ mit «Paste Values» einfügen (Zelle A1 für Szenario SH30, 
Zelle A3 für Szenario SH100, und Zelle A5 für Szenario SH300). 
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- Als Resultat des Datenimports erhält man folgende Resultate: 

o Übersichtstabelle Schwemmholzpotential: Für jedes Szenario und für jeden 
Eintragsprozess erhält man einen Überblick zum potentiellen Schwemmholzvolumen 
[m3 Festmeter] und die potentielle Eintragsfläche [ha] (prozentual in den Grafiken 
sowie in absoluten Zahlen in der Tabelle selbst). 

o Das Schwemmholzpotential wird auch für die kombinierte Eintragsfläche Vkombi (d.h. 
Überlappung der potentiellen Eintragsflächen aus Seitenerosion, Rutschung und 
Murgang) zusammengefasst. 

o Zusätzlich wird der prozentuale Anteil des Totholzes (Gerinneholz plus Totholz auf 
dem Waldboden liegend) berechnet sowie die Anzahl der aus den Eintragsflächen 
rekrutierten Baumstämme geschätzt. Diese Angaben stammen aus dem 
Schweizerischen Landesforstinventar LFI. 

o Schliesslich wird mithilfe der im Excel-Template definierten Abminderungsfaktoren 
die während eines Hochwassers tatsächlich auftretende Schwemmholzfracht 
abgeschätzt und grafisch zusammengefasst. 
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Anhang: Beschreibung der EGA Modell-Outputs 

Geodaten Output 

Nr. Model Output Beschreibung 
Geodatent
yp Geoprocessing (mit Nr.) 

1 VHMV_1m 
Holzvorrat lebend (growing stock) in der Waldfläche des Einzugsgebiets. Die Rasterwerte geben den Holzvorrat des jeweiligen 
Pixels (1x1 m) in m3 Festmeter an. Raster Resize and recalculate VHMV Input 

2 Wald_EZG Waldfläche (Silvaprotect) innerhalb des Einzugsgebiets Shapefile 
Clip Inputs Einzugsgebiet (EZG) & 
Waldfläche (Silva25) 

3 Gerinne Gerinne innerhalb des Einzugsgebiets; ohne unterirdische Strecken; verlinkt mit ökomorphologischen Daten Shapefile 

Clip Inputs EZG & Gewässernetz (GWN); 
Buffer gemäss Gerinnebreite 
Ökomorphologie 

4 Gerinnepotential_bewaldet Bewaldetes Gerinne innerhalb des Einzugsgebiets; relevant für SH-Mobilisierung Shapefile Intersect 2+3 (inkl. 25 m Buffer)  

5 
Murgang_HQxxx_gesamte_Flaeche_bew
aldet Selektierte und gepufferte Murgangtrajektorien (Silvaprotect); alle Eintragsflächen welche Wald und Gerinne überschneiden Shapefile 

Input Murgangtrajektorien -> Select by 
location (intersect mit GWN & Wald) 
Pufferung je nach Szenario (5, 10, 15 m) 
Intersect mit Wald 

6 Murgang_HQxxx Potentielle Eintragsfläche durch Murgänge; ohne Überschneidung mit anderen Prozessflächen Shapefile 5 ohne 3 

7 M_VHMV_HQxxx Lebender Holzvorrat der potentiellen Eintragsfläche durch Murgang Raster Intersect 1+6 

8 
Rutschung_HQxxx_gesamte_Flaeche_be
waldet Selektierte und gepufferte Rutschungstrajektorien (Silvaprotect); alle Eintragsflächen welche Wald und Gerinne überschneiden Shapefile 

Input Murgangtrajektorien -> Select by 
location (intersect mit GWN & Wald) 
Startpunkt Trajektorie max. 50 m Abstand 
vom Gerinne 
Pufferung je nach Szenario (5, 10, 15 m) 
Intersect mit Wald 

9 Rutschung_HQxxx Potentielle Eintragsfläche durch Rutschungen/Hangmuren; ohne Überschneidung mit anderen Prozessflächen Shapefile 8 ohne 3+6+12 

10 R_VHMV_HQxxx Lebender Holzvorrat der potentiellen Eintragsfläche durch Rutschungen/Hangmuren Raster Intersect 1+9 

11 
Seitenerosion_HQxxx_gesamte_Flaeche_
bewaldet Pufferung des Gerinnes gemäss definierten Rückgriffweiten; alle Eintragsflächen welche Wald überschneiden Shapefile 

Rückgriffweiten: Multiplikation mit 
Gewässerbreite (Ökomorphologie) 
Faktor je nach Szenario (1, 3, 4.5) 

12 Seitenerosion_HQxxx Potentielle Eintragsfläche durch Seitenerosion; ohne Überschneidung mit anderen Prozessflächen Shapefile 11 ohne 3+6 

13 S_VHMV_HQxxx Lebender Holzvorrat der potentiellen Eintragsfläche durch Seitenerosion Raster Intersect 1+12 

14 Eintragsflaeche_HQxxx_kombiniert Kombinierte potentielle Eintragsfläche durch die Überschneidung der Prozessflächen von Murgang, Rutschung & Seitenerosion Shapefile Intersect 6+8+11 

15 E_VHMV_HQxxx Lebender Holzvorrat der kombinierten potentiellen Eintragsfläche Raster Intersect 1+14 

16 Schwemmholzpotential_HQxxx Zusammenfassung der kumulierten Werte (Fläche, Volumen, Anzahl Stämme) aus den oben beschriebenen Outputs Tabelle  
        
Hin-
weis: HQxxx entsprechen den WoodFlow-Szenarien SH"30" | SH100 | SH"300"   
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Geodatabase-Table Output 

Nr. Header Beschreibung Einheit 
Berechnung mit 
Nr. 

1 Schwemmholzvolumen_HQ100 Totales Schwemmholzvolumen im Einzugsgebiet. Frisch- und Totholz zusammen 
m3 

(Festmeter) 

1+2+3+4+5 
oder 
21+22 

2 Seitenerosionsvolumen_HQ100 Potentieller Schwemmholzeintrag aus Seitenerosion gemäss Rückgriffweiten (Frisch- & Totholz) 
m3 

(Festmeter) 15+18 

3 Murgangsvolumen_HQ100 Potentieller Schwemmholzeintrag aus Murgängen gemäss Silvaprotect (Frisch- & Totholz) 
m3 

(Festmeter) 17+20 

4 Rutschungsvolumen_HQ100 Potentieller Schwemmholzeintrag aus Rutschungen/Hangmuren gemäss Silvaprotect (Frisch- & Totholz) 
m3 

(Festmeter) 16+19 

5 Gerinneholzvolumen_HQ100 
Potentieller Schwemmholzeintrag aus Mobilisierung von bereits im Gerinne vorhandenem Totholz gemäss Literatur/Statistik; Fokus auf bewaldetes 
Gerinne 

m3 

(Festmeter) Geodaten 

6 
Flaeche_Seitenerosionspotential_HQ10
0 Potentielle Eintragsfläche durch Seitenerosion (immer Waldfläche) m2 Geodaten 

7 Flaeche_Murgangspotential_HQ100 Potentielle Eintragsfläche durch Murgang (immer Waldfläche) m2 Geodaten 

8 Flaeche_Rutschungspotential_HQ100 Potentielle Eintragsfläche durch Rutschungen/Hangmuren (immer Waldfläche) m2 Geodaten 

9 Flaeche_Gerinne Bewaldete Gerinnefläche (max. 25 m Abstand vom Wald); berechnet mithilfe  Ökomorphologie (Gewässerbreite) bzw. Extrapolation davon m2 Geodaten 

10 Totholzvolumen_HQ100 Totholzvolumen des Schwemmholzpotentials gemäss LFI Datensatz (Totholzvorrat Wald), unterteilt nach Forstkreisen 
m3 

(Festmeter) Geodaten 

11 Holzvolumen_lebendig_HQ100 Frischholzvolumen des Schwemmholzpotentials gemäss LFI Datensatz (Schaftholzvolumen lebender Bäume im Wald), unterteilt nach Forstkreisen 
m3 

(Festmeter) Geodaten 

12 Anzahl_Staemme_gesamt_HQ100 
Kummulative Anzahl Stämme (lebend & tot), welche sich in der potentiellen Eintragsfläche von Murgang, Rutschung & Seitenerosion befinden 
(gemäss LFI Datensatz, unterteilt nach Forstkreisen) - 14+15 

13 Anzahl_Staemme_tot_HQ100 
Kummulative Anzahl abgestorbener Stämme, welche sich in der potentiellen Eintragsfläche von Murgang, Rutschung & Seitenerosion befinden 
(gemäss LFI Datensatz, unterteilt nach Forstkreisen) - Geodaten 

14 Anzahl_Staemme_lebendig_HQ100 
Kummulative Anzahl lebender Baumstämme, welche sich in der potentiellen Eintragsfläche von Murgang, Rutschung & Seitenerosion befinden 
(gemäss LFI Datensatz, unterteilt nach Forstkreisen) - Geodaten 

15 S_VHMV_Pot100 Potentieller Schwemmholzeintrag Frischholz aus Seitenerosionsflächen gemäss Vorratsangaben aus Vegetationshöhenmodel VHMV 
m3 

(Festmeter) Geodaten 

16 R_VHMV_Pot100 Potentieller Schwemmholzeintrag Frischholz aus Rutschungsflächen gemäss Vorratsangaben aus Vegetationshöhenmodel VHMV 
m3 

(Festmeter) Geodaten 

17 M_VHMV_Pot100 Potentieller Schwemmholzeintrag Frischholz aus Murgangsflächen gemäss Vorratsangaben aus Vegetationshöhenmodel VHMV 
m3 

(Festmeter) Geodaten 

18 S_tot_Pot100 Potentieller Schwemmholzeintrag Totholz aus Seitenerosionsflächen gemäss Verhältnis aus LFI-Daten 
m3 

(Festmeter) 15+(15*(10/11)) 

19 R_tot_Pot100 Potentieller Schwemmholzeintrag Totholzholz aus Rutschungsflächen gemäss Verhältnis aus LFI-Daten 
m3 

(Festmeter) 16+(16*(10/11)) 

20 M_tot_Pot100 Potentieller Schwemmholzeintrag Totholz aus Murgangsflächen gemäss Verhältnis aus LFI-Daten 
m3 

(Festmeter) 17+(17*(10/11)) 

21 SHpotential_lebend_HQ100 Gesamter potentieller  Schwemmholzeintrag Frischholz aus Eintragsflächen  
m3 

(Festmeter) 15+16+17 

22 SHpotential_tot_HQ100 Gesamter potentieller Schwemmholzeintrag Totholz aus Eintragsflächen  
m3 

(Festmeter) 18+19+20 
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Nr. Header Beschreibung Einheit 
Berechnung mit 
Nr. 

23 E_VHMV_Pot100 
Potentieller Schwemmholzeintrag Frischholz aus Verschneidung der Prozessflächen Rutschung, Murgang & Seitenerosion;  gemäss Vorratsangaben aus 
Vegetationshöhenmodel VHMV 

m3 

(Festmeter) Geodaten 

24 E_tot_Pot100 
Potentieller Schwemmholzeintrag Totholz aus Verschneidung der Prozessflächen Rutschung, Murgang & Seitenerosion;  gemäss Vorratsangaben aus 
Vegetationshöhenmodel VHMV 

m3 

(Festmeter) Geodaten 

25 Eintragsvolumen_kombi_HQ100 

Gesamter potentieller  Schwemmholzeintrag (Frisch- & Totholz) aus den überlappenden Eintragsflächen;  
entspricht einem minimal zu erwartendem Schwemmholzpotential bzw. definiert die Potentialflächen mit der grössten 
Mobilisierungswahrscheinlichkeit  

m3 

(Festmeter) 23+24 
        
Hinweis
: HQxxx bzw. Potxxx entsprechen den WoodFlow-Szenarien SH"30" | SH100 | SH"300"   
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